How to set presence in VoipNow

Applies to VoipNow 3 and higher!

The SIP Presence feature allows users to view the state of other users that belong to the same organization. To benefit from this feature, you must use a
telephone with SIP presence/BLF support.

This article shows how to set up SIP presence, monitor another extension and publish presence on commonly used telephones supporting such features.

Presence

You can monitor the state of one or several extensions by means of a series of special settings in the phone interface. To identify the users that you would
like to monitor, please use the full extension number. For example, if you want to monitor extension 0003* 001, then you must fill in 0003* 001 as the
monitored extension number.

Presence types by content
Dialog (BLF)

Snom
Grandstream
Thomson
Aastra
Linksys

Presence

® X-lite/EyeBeam/Bria (pidf)
® Polycom phones (xpidf)

An extension can publish its presence in any format, whereas the monitoring extension can subscribe for the presence status in any of the supported
formats as well.

Presence types by publishing mode

Published by the server

The presence of each monitored extension is published by the server by default.

If you are monitoring an extension with the published server presence enabled, you will be aware of its state even if the phone doesn't publish its presence.
Based on actual call events, the server decides which state of the monitored extension gets published to you.

Published by the phone

Some phones choose to publish their own presence and you may choose to rely on it, rather than on the info generated by the server.

In this case, the phone used by the monitored extension must be able to send PUBLISH requests to publish its presence.

If this phone does not support presence publishing or its user does not wish to publish their presence, then you will not be able to monitor this extension.

Nevertheless, the extension state that gets communicated to you may not be the actual state of the extension (for example, the phone may be online, but
the user may decide to publish its state as offline).

For more information on the particular use of this feature on your telephone, please view your phone user manual.
In order to activate this feature on the server you must follow the next steps:
1. In the VoipNow web interface, please select the extension you want to publish its own presence.

2. Then go to Extension Management Provisioning and SIP page.
3. Select the Extension publishes its own state option.

Snom
Snom 300/320/360/370
To set up SIP presence on Snom 300/320/360/370, take the following steps:

Log in to the Web Configuration Menu.

Click on Setup Function Keys Choose one of the Sx keys.

Pick the context associated to your account from the Context drop-down list.

From the Type drop-down list, select BLF (if this option is not available, please select Extension or Destination).
Enter the extension number you would like to monitor in the Number field.

Press the Save button to save your settings.
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7. In the end, please reboot the phone.
The LED near the function key displays the following behavior, depending on the state of the monitored extension:

® When the extension is idle, the LED is OFF.
® When the extension is busy or connected, the LED is ON.
® When the extension is ringing, the LED blinks.

Grandstream GXP20xx

Grandstream GXP20xx supports presence watching and also has the ability to publish its presence.
To monitor an extension using SIP presence on Grandstream GXP20xx, take the following steps:

. Log in to the Web Configuration Menu.

. Click on Basic Settings.

Then choose the desired Multipurpose Key.

. Click on Key Mode and select the Asterisk BLF option from the drop-down list.

Click on Account and choose the account number corresponding to your extension from the drop-down list.
. Enter the Name and extension number for the user you would like to monitor.

. Click the Update button to save your settings.

. In the end, please reboot the phone.
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The LED displays the following behavior, depending on the state of the monitored extension:

® When the extension is off-hook, in-use, or not registered, the LED turns RED.
® When the extension is ringing, the LED blinks RED.
® When the extension is idle, the LED turns GREEN.

To publish the presence of your own extension, take the following steps:

. Log in to the Web Configuration Menu.

. Click on the tab corresponding to your account.

. Find the PUBLISH for Presence option, and set it to Yes.
. Click the Update button to save your settings.

. In the end, please reboot the phone.
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Thomson ST2030

To set up SIP presence on Thomson ST2030, take the following steps:

1. Log in to the Web Configuration Menu.

2. Click on Advanced Voice Settings Advanced Locate the Multiline drop-down list.

3. Change the Multiline value to lower than 10, depending on how many line buttons you want (how many people you can put on hold and still get
another call) and how many BLFs you want. For example, choose 5 - leaving the left set of 5 buttons for lines, and the right set of buttons for
BLF's. Later in this article, we will refer to the number you chose as x.

. Press the Apply button in the lower right corner and ignore the subsequent warning message reading that it might be necessary to reboot the
phone at this point.

. Click on Advanced Voice Settings Advanced Call Feature Function Key Table.

. Do not fill in the first x Function Keys that you chose earlier (x is the value for Multiline).

. From the Type drop-down list for Function Key no x+1, select Supervised Line.

. Insert the extension number you would like to monitor in the Destination field on the right.

. If you want to monitor more that one account, please do the same for Function Key no x+2, x+3 etc (until the end of the table).

10. When you're done, please reboot the phone.
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The LED displays the following behavior, depending on the state of the monitored extension:

® When the extension is either off-hook or not registered, the LED is ON.
® When the extension is ringing, the LED blinks.
® When the extension is idle, the LED is OFF.

Aastra
Astra 480i/480i CT
To set up SIP presence on these Aastra phones, take the following steps:

. Log in to the Web Configuration Menu.

. Click Operation Softkeys and XML.

. Select a softkey to configure.

In the Type field, select BLF.

In the Label field, enter the name of the person whose extension you are monitoring.
. In the Value field, enter the extension you want to monitor.

. Make sure to select the Idle, Connected, Incoming, and Outgoing options.

. In the Line field, select the line number corresponding to your extension.
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9. Click Save Settings, then reboot the phone.

The busy and idle indicators will appear on the IP phone screen display next to the softkey programmed for BLF functionality. The indicators display the
following behavior, depending on the state of the monitored extension:

® When the extension is idle, an icon with the handset on-hook is displayed next to the BLF softkey.
® When the extension is in use, a small telephone icon with the handset off-hook is displayed.

Astra 6753i/9133i
To set up SIP presence on these Aastra phones, take the following steps:

. Log in to the Web Configuration Menu.

. Click Operation Programmable Keys.

. Select a programmable key to configure.

In the Type field, select BLF.

. In the Value field, please enter the extension you want to monitor.

. In the Line field, please select the line number corresponding to your extension.
. Click Save Settings, then reboot the phone.
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The LEDs next to each BLF programmable key display the following behavior, depending on the state of the monitored extension:

®* When the extension is either off-hook or not registered, the LED is OFF.
® When the extension is ringing, the LED blinks.
® When the extension is idle, the LED is ON.

Linksys phones

Linksys 942

Software Version needs to be 6.1.3(a) or higher.
To set up SIP presence on Linksys SPA942, take the following steps:

. Log in to the Web Configuration Menu.
. Click Admin Advanced Phone.
. Please scroll down and look for Line Key Extended Function under the Line Key 4 section.
. Select Asterisk from the Server Type drop-down list.
. For each extension or user that you want to monitor using the SPA942, you must setup a separate configuration in one of the Line Key fields:
® Change the Extension to Disabled.
® Enter a Short Name; it will appear as the text next to the button on the phone.
® Change Share Call Appearance to Shared.
® |nthe Extended Function field, you must enter the line:" f nc=bl f ; sub=noni t or ed_nane" in which you need to replace the monitore
d_extension, your_server_ip (the ip/hostname of your VoipNow server) and monitored_name fields with your custom values. For
example, if you want to monitor John Smith's extension no. 0003*001, on a VoipNow server with the IP address 192.168.100.1, you
should enter f nc=bl f ; sub=0003*001@.92. 168. 100. 1; nne=JohnS
6. Click Submit, then reboot the phone.
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The LED displays the following behavior, depending on the state of the monitored extension:

1. When the extension is idle, the LED turns GREEN.
2. When the extension is in use, the LED turns RED.
3. When the extension is ringing, the led turns RED and blinks.

Linksys 962 or 932

The presence feature is available only for Linksys SPA962 with the SPA932 programmable buttons.

Linksys SPA962

To set up SIP presence on Linksys SPA962, take the following steps:

. Log in to the Web Configuration Menu.

. Click Admin Advanced SPA932. If you do not see the SPA932 tab, please check your firmware version and upgrade, if necessary.

. Select Yes from the Unit 1 Enable drop-down list. If you have installed two SPA932 units, please also select Yes from the Unit 2 Enable drop-
down list.

. Then, select "Asterisk" from the "Server Type" drop-down list.

. Select "No" from the "Test Mode Enable" drop-down list.

. For each extension or user that you want to monitor using the SPA932, you must enter a configuration script in one of the key fields.
The configuration script consists in the line: " f nc=bl f ; sub=noni t or ed_nane" where you need to replace the monitored_extension, your_se
rver_ip (the ip/hostname of your VoipNow server) and monitored_name fields with your custom values. For example, if you want to monitor
John Smith's extension no 0003*001, on a VoipNow server with the IP address 192.168.100.1, you should enter the following line: fnc=blf;
sub=0003*001@192.168.100.1;usr=0003*001@192.168.100.1;nme="John Smith"

7. Click Submit and reboot the phone.
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The LED displays the following behavior, depending on the state of the monitored extension:



1. When the extension is idle, the LED turns GREEN.
2. When the extension is in use, the LED turns RED.
3. When the extension is ringing, the LED turns RED and blinks.

Yealink

Yealink T22P

To enable presence watching, take the following steps:
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Log in to the web configuration menu.

Go to Phone DSS key.

Please choose one line you want to use to monitor another one.

In the Type field, please select BLF.

Please enter the number you want to monitor in the Value field.

In the Line field, please select a line for which you wish to apply this key.
Press the Confirm key.

In order to have the Presence feature on your Yealink phone you need to use a firmware version v51 or newer.

The LED displays the following behavior, depending on the state of the monitored extension:

When the extension is not active as BLF or offline, the LED is OFF.

When the extension is idle, the LED turns GREEN.

When the extension receives an incoming call, the LED blinks GREEN fast.
When the extension is in a conversation, the LED blinks GREEN slowly.

Polycom

Polycom phones support presence watching.

Polycom 30x

To set up SIP presence on Polycom 30x, take the following steps:
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. Press the Menu button on your telephone keyboard.

. Select Features Contact List.

. Press Add to enter another contact into the phone database.

. In the Contact number field, please enter the extension number that you would like to monitor. This field is mandatory and must be unique (it

cannot be already in the list).

. You can leave the Speed Dial Index, Ring Type, and Divert Contact fields blank.
. Scroll to the Watch Buddy field, then switch this field to Enabled.
. Press Save to confirm, then reboot the phone.

To see the status of your monitored buddies, select the Buddies option on the lower right corner of your main display screen.

Polycom 320/330

To set up SIP presence on Polycom 320/330, take the following steps:

1.
2.
3.

4.

5.
6. Save the contact entry, then reboot the phone.

Press the Dir soft key.

Add a new entry to the list.

In the Contact number field, please enter the extension number that you would like to monitor. This field is mandatory and must be unique (it
cannot be already in the list).

You can leave the Speed Dial Index, Ring Type, and Divert Contact fields blank.

Scroll to the Watch Buddy field, then switch this field to Enabled.

To see the status of your monitored buddies, check the buddy list on your telephone.

Polycom 50x/550/560/650

To set up SIP presence on Polycom 50x/550/560/650, take the following steps:
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. Press the Directories button on your telephone keyboard.

. Select Contact Directory.

. Press More if necessary and then Add to enter another contact into the phone database.

. In the Contact number field, please enter the extension number that you would like to monitor. This is a required field and it must be unique (it

cannot be already in the list).

. You can leave the Speed Dial Index, Ring Type, and Divert Contact fields blank.
. Scroll to the Watch Buddy field, then switch this field to Enabled.
. Press Save to confirm, then reboot the phone.



To see the status of your monitored buddies, check the buddy list on your telephone.

X-Lite/EyeBeam/Bria

The present X-Lite/EyeBeam/Bria softphones support presence watching.

To set up SIP presence on X-Lite/EyeBeam/Bria, take the following steps:

1. In the main window, right-click and choose SIP Account Settings.
2. Then select your contact and click Properties.
3. Choose the Presence tab, click on Mode and choose: Peer-to-Peer if you only wish to see the status of other extensions, without publishing your
own status; or Presence agent, if you wish to see the status of other extensions and publish your own status at the same time.
4. Click on OK and then Close.
5. Open the Contacts window.
6. Right-click one of your groups and click Add Contact.
7. Then enter the name of the person whose extension you are monitoring.
8. In the Contact Methods list, please click Type and choose Softphone.
9. In the Phone/Address field, please enter the extension you want to monitor.
10. Tick the Show this contact's Availability checkbox.
11. Click on OK.

The Contacts will show the state of your monitored contact.
To publish the presence of your own extension, take the following steps:

1. Make sure you choose the Presence agent when setting up Presence agent in the previous steps.
2. If you are using Bria, you can choose your status using the drop-down box right under the File menu.
3. If you are using X-Lite or EyeBeam, you can choose your status using the drop-down box which appears at the top of your Contacts window.

The Buddy icon displays the following behavior, depending on the state of the monitored extension:

® |f the extension is not registered, the icon is OFF (grayish) with an OFFLINE status.
® |f the extension is ringing or busy/in-call, the icon turns RED with a BUSY status.
® |f the extension is idle, the icon turns GREEN with an ONLINE status.

Related articles

Understanding and blocking ghost calls

How to monitor VoipNow with Homer

How to use Homer capture agents with VoipNow
How SIP forking works in VoipNow
Understanding codec negotiation
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